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Introduction
It is usually convenient for the maintenance manager to be able to retrieve data on the supplier of 
equipment and spare parts.    By having access to data on suppliers, the maintenance manager can 
contact the supplier in case of some undocumented problem or,    depending on the distribution of 
authority in the company, order spare parts.    If the ordering of spare parts must be handled by the 
Purchasing Unit, he can at least provide the information needed to contact the correct supplier.

A database on the suppliers of equipment and spare parts accordingly serves the purpose of making 
the Maintenance Unit more efficient in handling its tasks. 



What SUPPLY is
SUPPLY is a companion program to MPM for control and management of a database on suppliers of
equipment and spare parts.    It thus complements the combination of spare parts inventory 
management provided by SPARES and    maintenance management supported by MPM.

SUPPLY cannot be run independently from MPM or SPARES, since the three    programs share 
some data.    It has been considered prudent to have them as separate, dependent programs, rather 
than joining them into one program.    The main reason for this is that data could inadvertently be 
erased if they were one.    Another important reason is that it allows the user to run at least two of the 
programs at the same time.

Examples of when it is useful to run two or three of the programs at the same time are:

n You are entering data on new equipment, using MPM, and want to enter data on the spare parts 
obtained with the equipment (SPARES).    [Alt]-[ESC] brings you to the Program Manager.    Load 
SPARES , enter data as required,    then [Alt]-[ESC] will bring you back to your first program 
again.

n You are entering data on equipment (MPM) or spare parts (SPARES) and want to add a new 
supplier or enter the equipment or spare part codes in the card for a supplier already included in 
the database. [Alt]-[ESC] brings you to the Program Manager.    Load SUPPLY, enter the data as 
required, then [Alt]-[ESC] will bring you back to your first program again.



How SUPPLY works
SUPPLY uses the data from MPM on inventory areas and equipment inventory and from SPARES on
spare parts.    It combines this data with information on the suppliers of equipment and spares to form
its complete database.

The SUPPLY and its database are used to provide the following:
n A data card with the name of the supplier, his street and mailing address, phone, fax and telex 

numbers, and the inventory codes for the equipment and/or spare parts he can supply.
n A complete listing of suppliers used by the company.    This list can be displayed on-screen, 

printed or saved to a file.
n Means for retrieval of the data on a specific supplier.
n Means for finding suppliers for a specific item of equipment or spare part.
n Listings of suppliers of a specific item of equipment or spare part.    These lists can be displayed 

on-screen, printed or saved to a file.



System requirements

Hardware requirements
n Personal computer using 286 type or higher microprocessor, with a hard disk drive (386 type or 

higher recommended).
n 2 MB of memory.
n EGA, VGA, Super-VGA, XGA, 8514/A or compatible video card with corresponding monitor.
n Mouse.

Software requirements
n Microsoft DOS version 3.1 or higher.
n Microsoft Windows version 3.0 or higher.
n MPM for Windows with the companion program SPARES.



Help on Help

Three routes to Help
You have access to the on-screen Help program in three ways:    As a specific menu item in the Help 
Menu, by pressing the [F1] key, or from the Help button in the dialog boxes.

Help as a menu item
The Help menu has two options for calling Help.    First, 'Help on SUPPLY', which gives you the 
Contents screen of Help.    From this you can access all the other screens and read them as an on-
screen manual for SUPPLY.    Second, there is the 'Help on Help' option, which calls this screen.

Help from F1
Help, obtainable by pressing the [F1] key is context-sensitive, that is, the Help screen displayed 
depends on what menu option was highligthed before [F1] was pressed.

If no menu item has been highlighted, Help displays its Contents screen.    Please note that Help 
cannot be accessed by pressing [F1] when a dialog box is displayed.

NOTE:    Sometimes, if you press [F1] several times, the menu ceases to repond to mouse clicks.    
The reason is that the command has not been given back to the menu.      To return the command to 
the menu in such cases, press the [Esc] key once.

Help for dialog boxes
The only way to acces Help when a dialog box is displayed is by clicking on the Help button of the 
box.    This displays the Help listing for dialog boxes.



Getting started

Introduction
Since SUPPLY is a dependent companion program of MPM and SPARES,    certain features of most 
Windows programs are absent to avoid loss of data.    These features, like 'New file' of 'Save As...' 
are available in MPM, but not in SPARES or in SUPPLY.

Closing the logo window
Starting a new database
New data on suppliers
Saving your work



Closing the logo window
The logo window is displayed continuously on the screen until you point at it with the mouse and click
the right mouse button.    An alternative is to press any key, except the [Alt] key.



Starting a new database
SUPPLY assumes that a database has already been created with MPM for the equipment and with 
SPARES for the spare parts inventory.    The suppliers database created with SUPPLY will then latch 
on to the previous ones.

Therefore, you must start by loading the MPM and    SPARES databases, using the 'Open...' option in
the File Menu.    This also activates the other menu choices which are greyed = inactive until the 
MPM and SPARES databases have been loaded.

The next step is to select 'New'    from the Supplier Menu.    This displays an empty supplier    card to 
be completed.    By    entering the data requested for each supplier, you create the new, additional 
database.



New data on suppliers
When the supplier card is displayed, the cursor is already at the first input window .    Use the [TAB] 
key to move from one input window to the next.    Press [Enter] only when you have finished entering 
data into the card.    The inputs are:
n The name of the supplier.    Make sure that you do not enter a name which is already in your 

database, unless you can make them distinguishable in some way.    If you enter exactly the 
same name on two cards, the program will refuse to accept the second input.

n The street address of the supplier.
n The postal address of the supplier, usually a Post Box number.
n The postal (zip) code of the location of the suppliers office.    Please note that the postal code 

may be in different positions in different countries.    For instance, in the US, it is usually given 
after the name of the city, whereas in most European countries it is written before the name of 
the city.

n The city in which the suppliers office is.
n The state, if applicable.
n The country.
n The telephone number of the supplier.
n The fax number of the supplier.
n The telex number of the supplier.
n The inventory codes for the equipment he can supply.
n The inventory codes of the spare parts he can supply.



Saving your work
To save your work, select 'Save' from the File Menu.    This will automatically save the supplier data 
in a file with the same name as the MPM and SPARES data, but with the extension '*.sup'.    Thus, if 
the equipment inventory data is in files beginning with    "MYFILE.MP1", the supplier data will be 
saved in "MYFILE.SUP".



Procedures

Introduction
The initial procedures and those used for entering new data and saving data have already been 
described.
Getting started

The remaining procedures are defined in the following:
Loading data
Retrieving a supplier card
Editing    and updating data
Deleting data cards
Listings of data on screen
Printing lists
Filing lists



Loading data
To load data for the equipment and spare parts inventories as well as for the supplier's database, 
click on the 'Open...' option in the File Menu.    Then select the appropriate file from the listing shown. 
This will load all the data required, unless the suppliers database    has not yet been created.

It will also activate the other menu options which until now have been grayed = inactive.



Retrieving a supplier card

Introduction
There are several options for retrieving a supplier card.    The card can thus be retrieved based on 
whatever information    is available.

1 The most common approach is probably that you know more or less the name of the supplier.    
In that case, click on 'Select/Edit' in the Supplier menu option.    This displays a listing of the 
names of all suppliers. Click on the supplier of your choice, then on 'OK' (You may also double-
click directly on the name of the supplier), and the card is displayed.

2 To find the supplier of a specific item of equipment, click on 'Find supplier' in the Equipment 
menu option.    This gives a listing of the equipment in the inventory.    Click on the name of the 
equipment, then on 'OK' (or double-click).    You now have a listing of the suppliers of that item of 
equipment.    Select on of the choices.    This displays the data card for that supplier.

3 To find the supplier of a specific spare part, click on 'Find supplier' in the Spares menu option.    
This gives a listing of the spare    parts in the inventory.    Click on the name of the spare part, 
then on 'OK' (or double-click).    You now have a listing of the suppliers of that spare part.    Select
on of the choices.    This displays the data card for that supplier.



Editing and updating data
There are several reasons why the data on a card would need to be updated.    For instance, the 
supplier may have moved, or his telephone or fax number has changed.    These are obvious 
reasons for updating.    Less obvious, but still important reasons are to add inventory codes for new 
items of equipment or new spare parts.    Please note that you cannot update the name of the 
supplier, except by deleting the card and completing a new one.

To update/edit the information in a card, once it is retrieved, proceed as follows:
n Move the cursor to the input window for which you want to make the change, using the [TAB]    

key or by clicking the left button of the mouse on that window.
n Change the input as required.
n Repeat the procedure for the other input windows of the card as required.
n Click on the 'OK' button or press the [Enter] key when you have finished.



Deleting data cards
To delete a data card, use the following procedure:
n Retrieve the supplier card. Please note that in this case you must retrive the card using the 

''Select/Edit' option in the Supplier Menu.
n Click on the delete button on the card.    A warning will be displayed.    Click on 'Yes' and the card 

is removed from the database.



Listings of data on screen

All suppliers
n Click on the 'All suppliers' option in the Suppliers Menu
n Click on 'Display'.
n This displays a listing of all suppliers, with information on in which country their office is, their 

phone number and their fax number.

All suppliers of a given item of equipment
n Click on the 'List suppliers' option in the Equipment Menu.
n Click on 'Display'.
n Select the inventory area for which you want the listing.
n This displays the list of all suppliers of that item, with information on the country in which their 

office is, their phone number and their fax number.

All suppliers of a given spare part
n Click on 'List suppliers' in the Equipment Menu.
n Click on 'Display'.
n Select the spare part from the listing displayed.
n This displays the list of all suppliers of that item, with information on the country in which their 

office is, their phone number and their fax number.

All equipment
n Click on 'Allt equipment' in the Equipment Menu.
n Select the inventory area for which you want the listing.
n This displays a list of all equipment, with information on inventory code, year of purchase, price, 

depreciation and present value.

All spare parts
n Click on 'All spares' in the Spares Menu.
n Click on 'Display'.
n This gives a complete listing of all spare parts in the inventory, with information on inventory 

code, spare part number, number of items in stock and the reorder level.

Clearing the lists on screen
The lists are all shown on screen in two windows; one with the headings, and the other for scrolling 
the data in the list.    When you have finished viewing the lists, point the mouse at one of the windows
at a time and click the right mouse button    Failure to clear the lists will cause the display of a 
warning before the program accepts subsequent listings.



Printing lists
Three listings can be printed:
n The list of all suppliers (Click on 'All suppliers' in the Suppliers Menu.
n The list of suppliers of a given item of equipment (Click on 'List suppliers' in the Equipment 

Menu).
n The list of suppliers of a given spare part (Click on 'List suppliers' in the Spares Menu).

To print these list, continue as follows:
n Click on the 'Print' option.
n Make sure your printer is switched on, connected to the right printer port and on line.
n Change the printer selection and setup, if necessary, otherwise click on 'OK'.
n Wait for the printer to finish printing.



Filing lists
Three lists can be saved to a file:
n A list of all suppliers (Click on 'All suppliers' in the Supplier Menu.
n A list of suppliers of a given item of equipment (Click on 'List suppliers' in the Equipment Menu).
n A list of suppliers of a given spare part (Click on 'List suppliers' in the Spares Menu).

To save these lists to a file, continue as follows:
n Click on 'File'.
n Select the directory to which you want to file it.
n Enter a name for the file.    The default extension is ,*.sul', but you can choose an extension of 

your own.
n Click on 'OK' or press [Enter] and the file is saved.



Menu commands
There are five options in the SPARES menu bar:
n File - with file related options and 'Exit'.
n Supplier - with options that relate to data inputs on suppliers and retriveal of supplier cards for 

viewing and/or editing.
n Equipment - with options for listing and retrieving data on suppliers for a given item of equipment.
n Spares - with options for listing and retrieving data on suppliers fo a given spare part.
n Help - mainly for accessing Help.

Related topics
File Menu
Supplier Menu
Equipment Menu
Spares Menu
Help Menu



File menu
There are five options in the File Menu:
n Clear data - This clears all data in the memory.    Use this option only if you have been working 

with one set of data and then want to load another set to replace it.    The option is essentially a 
safeguard against 'cross-breeding' of two data sets.

n Open... - Opens and loads equipment and spare parts data files in one go.
n Save - saves the supplier data.    There is no need to save the equipment inventory or spare 

parts data, since they can only be modified by the MPM and SPARES programs.
n Printer setup - To select printer and modify its setup, if needed.
n Exit - to exit from the program.    If there is a possibility that the data have been changed, the 

program will ask if you want to save.

Related topics
Loading data
Saving your work



Supplier menu
The Supplier Menu has three options:
n New - for input of data for a new supplier, not previously included in the database.
n Select/Edit - to select a supplier card for viewing, editing or deleting.
n All suppliers - for a listing of all suppliers, with their country of location, phone number and fax 

number.    The list can be displayed on-screen, printed or saved to a file.

Related topics
New data on suppliers
Retrieving a supplier card
Editing and updating data
Listings of data on-screen
Printing lists
Filing lists



Equipment menu
There are three main options in the Equipment Menu:
n List suppliers - to list the suppliers of a given item of equipment.    The list can be displayed on 

screen, printed or saved to a file.
n Find supplier - to retrieve a supplier card for a given item of equipment.
n All equipment - to list all equipment in an inventory area.

Related topics
Listings of data on screen
Printing lists
Filing lists
Retrieving a supplier card



Spares menu
There are threem main options in the Spares Menu:
n List suppliers - to list suppliers of a given spare part.    This list can be displayed on-screen, 

printed or saved to a file.
n Find supplier - to retrieve data on    a supplier of a given spare part.
n All spares - for an on-screen listing of all spare parts.

Related topics
Listings of data on screen
Printing lists
Filing lists
Retrieving a supplier card



Help menu
There are three options in the Help Menu:
n Help on SUPPLY - to access Help.
n Help on Help - to show how help can be accessed in various ways.
n About... - with some information on SUPPLY.



Dialog boxes
The program uses dialog boxes to communicate with the user.    Most of them are straightforward 
and only convey a message or a warning.    Two of them, however, are more important and one 
extremely important:
n Inventory area select box - expects a selection of inventory area for equipment.    Click on the 

item you want to select and then on 'OK'.
n Selection box - is used for selection from a list of suppliers, equipment or spare parts.    Click on 

the item you want to select and then on 'OK'.
The most important one is, of course the box that represents the supplier card.

Related topics
New data on suppliers
Deleting data cards
Editing and updating data



Copyright
Copyright © 1993,    Börje Kyrklund.
All rights reserved.



Registration
Since SUPPLY is a companion program to MPM, no separate registration is needed.    See the 
corresponding item in MPM for information on registration.



Technical support
See the corresponding item in MPM for information on technical support.



MPM
Maintenance Planning and Management






